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Microsimulation Network Study Area 
1. Microsimulation Network General Information  

 
The analysis of modifications to the Modified selected Alternative (MSA) will be based on the TransModeler network 
for the MSA and the associated Project and Scenario files.  The primary analysis will make use of the 2040 morning 
and afternoon peak hour scenarios, but information will be provided should interim year analyses, such as for a ‘year 
of failure analysis’, of the MSA is necessary for the 2020, 2030, and 2035 scenarios.   
 
The original I-20/I-26/I-126 System Interchange Modification Report (the System IMR), dated May 2019, presented 
the anticipated interchange modifications as depicted in the Final Environmental Impact Statement (FEIS) for the 
project.  Since the approval of the System IMR, the Carolina Crossroads I-20/I-26/I-126 Corridor Improvement Project 
(Carolina Crossroads Program) has been separated into five construction phases.  The first three phases of the Carolina 
Crossroads Program comprise most of the work documented in the System IMR.  Improvements to the I-126 at 
Colonial Life Boulevard interchange are now part of Phase 1 of the Carolina Crossroads Project Delivery while the I-20 
Exit 65 Interchange at Broad River Road is now part of Phase 2.  Phases 1 and 2 are both underway as design-build 
projects and the design has been substantially completed.  The improvements to I-20/I-26/I-126 system interchanges, 
along with I-20 Exit 63 (Bush River Road) and I-26 Exit 106 (St. Andrews Road) are now part of Phase 3, which will also 
be a design-build project. Traffic Technical Memoranda addressing changes to the I-126 Colonial Life Boulevard 
interchange and I-20 Exit 65 (Broad River Road) were submitted as part of the Phase 1 and Phase 2 design-build 
projects, ID P039718 and ID P039719, respectively. The project phasing is shown in Figure 1. 
 
As the evolution of the Carolina Crossroads Program through the phased construction delivery is discussed, it is 
important to understand the key terms that define various milestones in the evolution of the design as it relates to 
the FEIS and the Record of Decision (ROD) for the Carolina Crossroads Program and the System IMR.  The design 
concept depicted in the FEIS was referred to as the Refined Recommended Preferred Alternative (RRPA), which as 
the name implies was a refinement to the Recommended Preferred Alternative (RPA) presented the in the Draft EIS.  
Since the System IMR was developed in parallel with the EIS documents, the nomenclature associated with the design 
concept in the documents was consistent and therefore the System IMR refers to the design concept used in the 
“Build” analysis as the RRPA.  Once the ROD was issued in May of 2019, the RRPA concept became known as the 
Selected Alternative (SA); however, many of the reference documents to the FEIS/ROD were not updated to reflect 
this change in nomenclature, including the System IMR.  Therefore, the terms RRPA and SA are synonymous.   
 
As the Carolina Crossroads Program has advanced through the initial construction phases and right-of-way acquisition, 
the design concept has been updated periodically.  These updates include changes to the design associated with the 
final design that have been developed during Phases 1 and 2 and changes made to the design concept outside of 
Phases 1 and 2 based on refinements made during right-of-way acquisition throughout the entire limits of the Carolina 
Crossroads Program.  The version of the design concept that includes all of these changes is referred to as the Modified 
Selected Alternative (MSA).  The MSA is fluid and will continue to evolve as the Carolina Crossroads Program is 
constructed. 
 

a. Microsimulation Network Limits 

The project area is displayed on Figure 2. The microsimulation network includes the entire project area, and 
consists of Interstates 20, 26, and 126, their interchanges and ramps, arterial roadways, and several frontage 
roads. 
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Figure 1. Carolina Crossroads Project Phasing 
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Figure 2. Project Area 

 

For traffic simulation and analysis purposes, the portion of I-20 in the microsimulation network extends 
outside of the project area towards the US 378 interchange (Exit 61) to the west and to the Monticello Road 
interchange (Exit 68) to the east.  The I-26 portion of the network extends from the west of the Broad River 
Road interchange (Exit 101) to the east of the US-378 (Exit 110) interchange.  The I-126 portion of the 
network begins at I-26 and extends to the east past the project limits east of the Colonial Life Boulevard 
interchange to the Elmwood Avenue – Huger Street split.   

Microsimulation network segments are organized based on their functional classification.  The functional 
classification is important to the modeling of the network and the performance of the dynamic traffic 
assignment as each functional classification has specific speeds and capacities associated with them.  
Selection sets have been made within TransModeler to color code the functional classifications to facilitate 
the identification of the classification of the various links in the network. 

There shall be no change to the existing functional classification of the MSA network segments.  When 
modifications to the network are developed, the functional classification of links added to the network or 
modified within the network should be carefully considered and be consistent with comparable roadways in 
the network. 
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b. Freeway Sections (Mainline Segments, Interchanges, and Ramps) 

Mainline Segments 

Within the MSA microsimulation network, the mainline freeway segments have the functional classification 
of Freeway and Expressway. The mainline freeway sections consist of one-way sections of interstates 20, 26, 
and 126 of various lengths.  The number of lanes on the freeway segments vary from three (3) to seven (7) 
with speed limits of 55, 60, and 70 miles per hour.  The three Freeway sub-classes are based on the coded 
speed limits and are identified as Freeway (55), Freeway (60), and Freeway (70). There is a single Expressway 
link coded into the network:  this is the connection from I-126 westbound to the I-26 westbound collector-
distributor road leading to the I-20/I-26 system interchange.  

Interchanges 

The existing network consists of thirteen service Interchanges. The existing interchanges included on I-26 in 
the network are: 

• Exit 101 - Broad River Road (US 176) 
• Exit 102 - Lake Murray Boulevard (SC-60) 
• Exit 103 - Harbison Boulevard (S-32-757/S-40-757) 
• Exit 104 - Piney Grove Road (S-32-671/S-40-1280)  
• Exit 106 - St Andrews Road (S-32-36/S-40-42) 
• Exit 108 - Bush River Road (S-32-273/S-40-31)  
• Exit 110 - Sunset Blvd (US 378) 

The Exit 108 ramps to and from Bush River Road are removed in the MSA. 

The existing service interchanges along I-20 are: 

• Exit 61 – Sunset Boulevard (US 378) 
• Exit 63 - Bush River Road (S-32-273) 
• Exit 65 - Broad River Road (US 176) 
• Exit 68 – Monticello Road (SC 215) 

The existing service interchanges along I-126 are: 

• Colonial Life Boulevard (S-40-2963) 
• Greystone Boulevard (S-40-3020) 

The eastern end of I-126 is the split for Elmwood Avenue (US 21/321) and Huger Street (US 21/321) 

There are two system interchanges: 

• Exit 107 - I-20/I-26 
• Exit 108 - I-26/I-126 
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Ramps 

There are two functional classifications for the ramps in the MSA microsimulation network.  The Ramp 
classification is assigned to links that connect the mainline freeway segments to arterial roadways at the 
service interchanges. The System Ramp classification is assigned to links connecting interstates either directly 
or indirectly through collector-distributor roads at the system interchange.   

Merge/Diverge/Weaving Areas 

Ramps also have an influence area for merge, diverge, and weaving segments. The influence area for each of 
the existing merge and diverge segments is 1500 feet and for each of the existing weave segments is 2500 
feet. Any new merge, diverge, or weaving segment shall be coded with these influence areas. 

c. Collector-Distributor Roads 

The functional classification Collector-Distributor (C-D) is assigned in the MSA to roads that usually run parallel 
to the mainline Freeway links.  C-D links are used to separate traffic traveling to and from the system 
interchanges from either the mainline freeway segments or from ramps at the service interchanges adjacent 
to the system interchange.  C-D links were used in the MSA to reduce the number or merge, diverge, and 
weaving sections, and reduces or eliminates the existing complex weaving movements adjacent to the system 
interchanges, reducing traffic conflict points. 

d. Arterial, Collectors, and Local Streets  

The links not classified as Freeway, Expressway, Ramp, System Ramp, or Collector-Distributor represent 
surface streets connecting the traffic zones to the interchanges or connecting other surface streets.  These 
links have the functional classification of Major Arterial, Minor Arterial, Collector, and Local Street.   

Two types of Major Arterial links are present in the network based on their coded speeds: Major Arterial (35) 
and Major Arterial (45) are the functional classifications used for major arterial links with coded speed limits 
of 35 mph and 45 mph respectively.  The following roadways are coded as either Major Arterial (35) or Major 
Arterial (45) in the MSA microsimulation network: 

• Colonial Life Boulevard  
• Elmwood Avenue  
• Huger Street 
• Monticello Road 
• Sunset Boulevard 

Links with the functional classification of Minor Arterial in the MSA network have a 35 mph coded speed.  The 
following roadways are coded as Minor Arterials in the network: 

• Broad River Road 
• Bush River Road 
• Greystone Boulevard  
• Harbison Boulevard 
• Lake Murray Boulevard 
• Leaphart Road 
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• Piney Grove Road 
• St Andrews Road  

Links with the Collector functional classification are used in the network to bring traffic to the Major Arterial 
and Minor Arterial links.  Collector links can be found crossing Sunset Boulevard around Exit 61 on I-20, Broad 
River Road near the Greystone Boulevard interchange on I-126, across Broad River Road near Exit 65 on I-20, 
and across Monticello Road near Exit 68 on I-20. Collector links in the network have a 35 mph coded speed 
and a lower link capacity than the Minor Arterial links.  The following links are coded with the Collector 
functional classification: 

• Arrowwood Road 
• Blue Ridge Terrace 
• Buckner Road 
• Corley Mill Road 
• Cromer Road  
• Davega Drive  
• Dutch Square Boulevard  
• Ginny Lane 
• Longcreek Drive 
• Stoneridge Drive 
• Peeples Street  

The Local Street functional classification is the most prevalent classification in the MSA network. Local Street 
links in the network have a 30 mph coded speed.  The following links are coded with the Local Street functional 
classification.
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• Beatty Road 
• Bower Parkway 
• Briargate Circle 
• Broad River Road 
• Burning Tree Road 
• Bush River Road 
• Candi Lane 
• Chartwell Road 
• Club Road 
• Chris Drive 
• Crossbow Drive 
• Colonial Life Boulevard W 
• Columbiana Drive 
• Columbiana Circle 
• Elm Abode Terrace 
• Fairlane Drive 
• Fernandina Road 
• Frontage Road 
• Harbor Drive 
• Hebron Drive 
• Hospital Drive 
• Independence Avenue 
• Jamil Road 
• Kay Street 
• Kennerly Road 

• Kinley Road 
• Laurel Street 
• Lawrence Street 
• Lost Creek Drive 
• Marley Drive 
• Mcswain Drive 
• Morninghill Drive 
• Nottingwood Drive 
• Nunamaker Drive 
• Oakwood Drive 
• Paisley Lane 
• Parkridge Drive 
• Park Terrace Drive 
• Piney Woods Road 
• Riverhill Circle 
• Seminole Road 
• St Andrews Parkway 
• Summer Place Drive 
• Sunset Court 
• Tram Road 
• Western Lane 
• Woodcross Drive 
• Woodland Hills Road 
• Young Drive 
• Zimalcrest Drive

•  

There is one set of links coded with the Roundabout functional classification.  These links are located in the 
network at the intersection of Piney Grove Road and Piney Woods Road.   

e. Intersections 

In the MSA network, intersections are formed where two links intersect.  With a network as large as the MSA 
network, there will be a large number of intersections.   

The key intersections associated primarily with the various service interchanges, and the type of traffic control 
used at each intersection are presented in Table 1 and Table 2.  
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Table 1. Intersection Analysis. Part 1 

  
 

Interchange # Intersection Name Traffic Control
Broad River Road (US 176) at Columbiana Drive / Lordship Lane Traffic Signal
Broad River Road (US 176) at I-26 EB Off-ramp 1-Way Stop Control
Broad River Road (US 176) at I-26 EB On-ramp Traffic Signal
Broad River Road (US 176) at I-26 WB On-ramp No Control
Broad River Road (US 176) at Western Lane Traffic Signal
Lake Murray Boulevard (SC 60) at Columbiana Drive Traffic Signal
Lake Murray Boulevard (SC 60) at I-26 EB On-Ramp No Control
Lake Murray Boulevard (SC 60) at I-26 WB On-Ramp No Control
Lake Murray Boulevard (SC 60) at Parkridge Drive / Kinley Road Traffic Signal
Harbison Boulevard (S-757) at Columbiana Drive Traffic Signal
Harbison Boulevard (S-757) at Park Terrace Drive / Columbiana Circle Traffic Signal
Harbison Boulevard (S-757) at Saturn Parkway Traffic Signal
Harbison Boulevard (S-757) at I-26 EB Ramps Traffic Signal
Harbison Boulevard (S-757) at I-26 WB Ramps Traffic Signal
Harbison Boulevard (S-757) at Woodcross Drive Traffic Signal
Piney Grove Road at Bower Parkway / Jamil Road Traffic Signal
Piney Grove Road at I-26 EBR Off-ramp No Control
Piney Grove Road at I-26 EB Ramps Traffic Signal
Piney Grove Road at I-26 WB Ramps Traffic Signal
Piney Grove Road at I-26 WBR Off-ramp No Control
Piney Grove Road at Fernandina Road Traffic Signal
St. Andrews Road at Jamil Road Traffic Signal
St. Andrews Road at Woodland Hills Road Traffic Signal
St. Andrews Road at I-26 SPUI Intersection Traffic Signal
St. Andrews Road at I-26 WBR Off-ramp 1-Way Stop Control
St. Andrews Road at Fernandina Road/Burning Tree Drive Traffic Signal
St. Andrews Road at Kay Street / Chartwell Road Traffic Signal
Bush River Road at Zimalcrest Drive Traffic Signal
Bush River Road at Driveway Traffic Signal
Bush River Road at Morninghill Drive Traffic Signal
Bush River Road at Arrowwood Road Traffic Signal

Exit 101

Exit 102

Exit 103

Exit 104

Exit 106

Exit 108
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Table 2.  Intersection Analysis. Part 2 

   

Interchange # Intersection Name Traffic Control
Sunset Boulevard (US 378) at E. Hospital Drive / Harbor Drive Traffic Signal
Sunset Boulevard (US 378) at I-26 EBR Off-Ramp Traffic Signal
Sunset Boulevard (US 378) at I-26 Single Point Ramps Intersection Traffic Signal
Sunset Boulevard (US 378) at I-26 WBR Off-Ramp Traffic Signal
Sunset Boulevard (US 378) at Chris Drive / McSwain Drive Traffic Signal
Bush River Road at  Outlet Pointe Boulevard Traffic Signal
Bush River Road at Berryhill Drive Traffic Signal
Bush River Road at I-20 WB Ramps Traffic Signal
Bush River Road at I-20 EB Off-Ramp Traffic Signal
Bush River Road at Independence Avenue Traffic Signal
Broad River Road at Marley Drive / Briargate Circle Traffic Signal
Broad River Road at I-20 WB Ramps / North Crossover Traffic Signal
Broad River Road at I-20 EB Ramps / South Crossover Traffic Signal
Broad River Road at Longcreek Drive Traffic Signal
Broad River Road (US 176) at Kinley Road Traffic Signal
Broad River Road (US 176) at Harbison Boulevard Traffic Signal
Broad River Road (US 176) at Piney Woods Road / Lost Creek Drive Traffic Signal
Broad River Road (US 176) at Piney Grove Road Traffic Signal
Broad River Road (US 176) at St. Andrews Road Traffic Signal
Broad River Road (US 176) at St. Andrews Parkway Traffic Signal
Broad River Road (US 176) at Seminole Road / Young Drive Traffic Signal
Broad River Road (US 176) at Dutch Square Boulevard Traffic Signal
Broad River Road (US 176) at Bush River Road Traffic Signal
Broad River Road (US 176) at Greystone Boulevard Traffic Signal
Greystone Boulevard at Stoneridge Drive Traffic Signal
Greystone Boulevard at I-126 WB Ramps 1-Way Stop Control
Greystone Boulevard at I-126 EB Ramps 1-Way Stop Control
Colonial Life Boulevard at I-126 Crossover Ramps/W Colonial Life Road Traffic Signal
Bush River Road at Colonial Life Boulevard Traffic Signal
Colonial Life Boulevard at West Colonial Life Road Traffic Signal
Park Terrance Drive at Bower Parkway Traffic Signal

Exit 63

Exit 65

Additional 
Intersections

Exit 110
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2. ATC Applicability (Locations) 

The microsimulation network should not be extended behind the current limits in the MSA network.  Any revisions 
to the limits of the microsimulation network shall be thoroughly documented and submitted along with the ATC. 
 
Links associated with the interstate routes (mainline segments, interchanges, and ramps) and the C-D roads that 
are modified or created as part of the development of an ATC should be consistent with the coded segments in 
the MSA.  For example, in an area of the MSA where freeway links are coded with the functional classification of 
Freeway (55), any new or modified links should be coded with the Freeway (55) functional classification.   
 
The coding of new and/or modified ramps, system ramps, and/or C-D roads in the ATC shall be documented and 
coded consistent with the coding of the comparable links in the MSA.  
 
Modifications to the MSA network shall be limited to Phase 3 and not modify work done in previous phases outside 
of tie-in locations or work specified as part of the contract. The project phased construction map is displayed on 
Figure 1. 
 
Modifications to the microsimulation network interchange configurations, aside from possible adjustments to 
merge and diverge locations with the mainline, should not be necessary at the following interchange locations: 
 
I-26 service interchanges at 

• Exit 101 - Broad River Road (US 176) 
• Exit 102 - Lake Murray Boulevard (SC-60) 
• Exit 104 - Piney Grove Road (S-32-671/S-40-1280)  
• Exit 110 - Sunset Blvd (US 378) 

I-20 service interchanges at: 

• Exit 61 – Sunset Boulevard (US 378) 
• Exit 65 – Broad River Road (US 176) 
• Exit 68 – Monticello Road (SC 215) 

I-126 service interchanges at: 

• Colonial Life Boulevard (S-40-2963) 
• Greystone Boulevard (S-40-3020) 

Modifications to the microsimulation network links classified as Major Arterial (35), Major Arterial (45), Minor 
Arterial, Collector, Local Street, and Roundabout shall be limited to the network links directly affected by 
modifications made at specific service interchanges.  All network surface street deletions, additions, and/or 
modifications shall be documented. 
 
Signalized and unsignalized intersections already coded within the microsimulation network shall only be modified 
when directly affected by the modifications made at specific service interchanges.  New and/or modified 
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intersections controlled by traffic signals shall have appropriate signal phasing and timing settings consistent with 
SCDOT’s guidelines.  The coded phasing and timing of existing signals should be used as a starting point for signals 
that are to be modified.   
 
SCDOT guidelines shall be followed for the setting of minimum green times, vehicle extensions, clearance (yellow 
and all-red) times, recall modes, and left turn phasing (protected-only, permitted-only, and protected-permitted) 
and concurrent right turn phases.  Pedestrian timings (Ped Walk+FDW) should be omitted except in cases where 
an exclusive pedestrian phase is included in the signal phasing.  
 
In TransModeler, the lost time for each phase is calculated as the sum of the Yellow and Red Clearance timings.  
When these timings are modified for a phase, the lost time for that phase will automatically get updated.  
 
Vehicle detector placement, detector length, and detection delays, recall mode, and memory mode settings shall 
be consistent with SCDOT guidelines.   
 
Signals placed within a coordinated signal system or placed within 1,500 feet of the end of a coordinated signal 
system shall be coded as a coordinated signal.  Coordination settings, such as coordinating to the beginning of the 
phase 2 and/or phase 6 yellow interval, shall follow SCDOT guidelines 
 
Coding Network Changes 

Link-wide Sensors, twenty feet in length, shall be added to all ramps and mainline segments.  These sensors will 
be identified as Vehicle-to-Roadside (VRC) Communication Data with vehicle detection set to “None”. Settings for 
the VRC Sensors shall be as shown in Figure 2. These sensors are used for the collection of truck classification 
volumes on the links. 

Figure 3 – VRC Sensor Settings 
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At revised/new merge locations (or the start of a weaving segment) for proposed designs, the combined link shall 
begin at the point where the full width of the approach ramp (or loop ramp) would intersect the edge of pavement 
for the mainline through lanes on the freeway.  Similarly, the diverge (or end of freeway weave segment) for the 
proposed design should end at the point where the full width of the departing ramp (or loop ramp) would intersect 
the edge of pavement for the mainline. Merge and diverge segments shall be coded to have an influence area of 
1,500 feet in length for the freeway analysis.  Weaving segments shall be coded to have an influence area of 2,500 
feet in length for the freeway analysis. 

 
3. Analysis Scenarios in TransModeler  

 
The following information relates to elements of creating and running the simulations for the MSA and any 
modified network to test alternative concepts to the MSA. 
 

a. Version and Build 
 
Caliper’s microsimulation modeling software, TransModeler (version 4.0 build 6275 64-bit), shall be used 
for modeling the MSA and any alternative concepts, and for generating the reports of the simulation 
results.  No other version of TransModeler shall be accepted without written verification from Caliper 
that the version of TransModeler being used is compatible with version 4.0, build 6275, 64-bit. 
 

b. Project Files and Scenarios.  
 
The following TransModeler files have been included to be used as a basis for future analysis:  
 
• CC_NB.smp includes the 2040 no-build network, and the 2040 no-build morning peak hour (NB_AM) 

and 2040 no-build afternoon peak hour (NB_PM) scenario trip tables.  
•  (CC_MSA.smp) includes the MSA microsimulation network and 2020 AM, 2020 PM, 2025 AM, 2025 

PM, 2030 AM, 2030 PM, 2040 AM, 2040 PM scenarios for the morning and afternoon peak hours.   

These files include all associated files such as trip tables, signal timing controls and scenario specific 
parameters. The 2040 AM/PM scenarios shall be used to evaluate any alternative concept modifying the 
MSA.  The remaining scenarios are provided for interim year and/or ‘year of failure’ assessments should 
they be required. 

Alternative concepts shall be prepared by copying the MSA Project File and creating a separate, unique 
alternative Project File.  It is recommended that concise, descriptive Project File names, such as 
CC_ATC_01.smp are used to help identify the alternative associated with the concept developed and 
submitted for review.   
 

c. Simulation Project Settings.  
 
Settings for each Project File can be accessed by selecting Project->Settings from the menu.  
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The specific Project Settings used in modeling the MSA are outlined in Figure 4 to Figure 18. The figures 
include the Project Settings for the Setup, Network, Input, Output, Routing, Parameters, and Options tabs. 
The few settings that may be changed on these tabs are noted.  Most settings shall not be changed.  If 
the settings identified as those that shall not be changed are modified, valid results are not guaranteed 
and comparisons between the MSA and Alternative Concept outputs cannot be made. 
 
The Setup tab for the MSA AM and PM peak hour scenarios are shown in Figure 4 and 5.  Aside from the 
Current Scenario and Scenario Folder Path, these settings shall not be changed.  The Start Time and End 
Time of the Simulation Period, the Preload setting under the Initial State and its corresponding Maximum 
Preload Time, and the Optional Project Settings shall be consistent for the AM and PM peak hour scenarios 
as shown.   
 
Figure 4 - Project Settings Setup Tab 2040 AM 

 

Figure 5 - Project Settings Setup Tab 2040 PM 

 

Figures 6 and 7 show the Network tab under Project Settings for the MSA AM and PM scenarios.  The 
Road Network Database should show the appropriate network file.  The MSA network database file 
CC_MSA.dbd is used in any simulation of the MSA.   

When working in a Project File for an Alternative Concept, the Road Network Database entry should 
reference the appropriate file created for the roadway network for that alternative.  For example, a 



 

Phase 3 TransModeler Settings and Parameters  
 

August 2022 Microsimulation Network Study Area 
  Page 14 

modified Road Network Database file created for an alternative named CC_ATC_01.dbd would be shown 
in the Road Network Database.   

The Speed and Capacity settings for Free Flow Speed, Capacity, Lane Capacity, Lane Sat. Flow (Lane 
Saturation Flow) were set as part of the calibration process and shall not be modified in future analyses. 
 

Figure 6 - Project Settings Network Tab 2040 AM 

 

Figure 7 - Project Settings Network Tab 2040 PM 

 

Figures 8 and 9 show the Input tab under Project Settings for the MSA AM and PM scenarios.  The five 
files shown under the Trip Tables are selected based on the year of the scenario.  The four individual trip 
matrix files and the file CC_MSA_TMC.bin shown under the Trip Tables shall not be modified.  

There are separate matrices for automobile trips and for truck trips.  The trip matrix files also contain the 
information concerning the peak-hour factor, terrain type, and other factors.  This includes the vehicle 
composition/mix for autos and trucks.  These elements of the trip matrix files shall not be modified.   

Traffic volume information for all existing and all future year scenarios is based on these trip tables.  The 
trip tables are assigned through the network based on the origin-destination matrices using the Dynamic 
Traffic Assignment (DTA) feature in TransModeler.  
 
Under the Input tab, the Signals file CC_MSA_Signals.tms and the Turn Prohibition file 
CC_MSA_TurnProhibition.bin are specific to the MSA.  These files may be modified as necessary to account 
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for changes in the coding of traffic signals in an Alternative Concept, and to add turn prohibitions as 
needed to prevent illegal or undesired turn movements.  As described previously, the signal coding should 
be consistent with SCDOT guidelines.  The files should have a file name consistent with the Alternative 
Concept name.  All changes to the Signals and Turn Prohibition Input Files shall be documented to facilitate 
review. 

 

 

Figure 8 - Project Settings Input Tab - 2040 AM 

 

Figure 9 - Project Settings Input Tab - 2040 PM 

 

 

 

The Trip Matrix settings are presented in Table 3 below: 
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Table 3 - Trip Matrix Settings 

 

Ensure the ‘Probe’ setting is set to ‘Yes’ in the Trip Content Matrix Settings for all matrices. 

Figure 10 - Trip Matrix Settings  

 

The curve-based time distribution is displayed in Table 4. 

Table 4 - Curve-Based Time Distribution 

 

 
Figures 11 and 12 show the Output tab under Project Settings for the MSA AM and PM scenarios. The 
Folder location shown under Output Selection should be located in the Project folder->Output folder.   The 
first five Output Groups – Trip Statistics, Flow & Travel Time, Delay, Lane Queue, and Spillback Queue - 
shall be selected.  The Step size shown for each of the Output Groups shall not be modified.  VRC Sensor 

Field _AM_Warmup.mtx _AM.mtx _PM_Warmup.mtx _PM.mtx
Time Interval: Start Time 6:45 7:15 16:15 16:45
Time Interval: End Time 7:15 8:15 16:45 17:45
Matrix Unit Hourly Rate Hourly Rate Hourly Rate Hourly Rate
Time Distribution Constant Over Time Curve-based Constant Over Time Curve-based
Unit Scaling Factor 0.370 1.00 0.400 1.00
Standard Deviation 0.00 0.00 0.00 0.00
Generate Departure Headways by O-D O-D O-D O-D

Departure Headways Distribution
Random 

(Negative Exponential)
Random 

(Negative Exponential)
Random 

(Negative Exponential)
Random 

(Negative Exponential)

AM Peak PM Peak

Begin Time Percentage Begin Time Percentage
7:15 24% 16:45 25%
7:30 26% 17:00 27%
7:45 27% 17:15 26%
8:00 23% 17:30 22%

AM PM
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Data may be checked to extract ATC specific truck percentages if necessary, such as for providing inputs 
to noise/air analyses.   
 
 

Figure 11 - Project Settings Output Tab – 2040 AM 

 

Figure 12 - Project Settings Output Tab - 2040 PM 

 

 

 

Figures 13 and 14 show the Routing tab under Project Settings for the MSA AM and PM scenarios.  The 
Route Choice settings for “Method” and “Link Exclusions” shall be set to “Stochastic Shortest Path” and 
“None” respectively, and the box for “Use turning delays” shall be checked.   
 
Under Travel Time and Turning Delay, the appropriate travel time files from the Project File and Simulation 
shall be used for the Historical and Turning Delay entries.  The files shall not be modified.  The “First Time 
Field(s)”, “Num. of Intervals”, “Start Time” and “Interval (min)” shall be set as shown. 
 
Global Turning Delays shall be set as shown for Right Turn, Through, Left Turn, and U-Turn movements. 
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Figure 13 - Project Settings Routing Tab - 2040 AM 

 

Figure 14 - Project Settings Routing Tab - 2040 PM 
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Figures 15 and 16 show the Parameters tab under Project Settings for the MSA AM and PM scenarios.  
The Parameters file CC_Parameters.xml under Model Parameters is Project based and will be the same in 
the AM and PM peak models.  The parameter file name should remain the same and shall not be modified. 
 
The Step Sizes shall be set for the AM and PM peak hour models as shown for the Microscopic, 
Mesoscopic, and Macroscopic Model Fidelity.  The entries under Local Segment/Link Parameters – Desired 
Speed Adjustment, Lateral Clearance, Block Intersection Compliance, and Lane Changing Compliance – 
and the Connector Waiting Zone under Local Lane Connector Parameters shall all be set to “None”.   
 
Under the Local Centroid Connector Parameters, the Inbound Weight and Outbound Weight parameters 
shall be set as shown. Those weight parameter files shall not be modified. 

 

Figure 15 - Project Settings Parameters Tab - 2040 AM 

  

Figure 16 - Project Settings Parameters Tab - 2040 PM 
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Figures 17 and 18 show the Options tab under Project Settings for the MSA AM and PM scenarios. The 
Simulation Info, Display, Unit Preferences, and Advanced Routing Options shall be set as shown.   

 

Figure 17 - Project Settings Options Tab - 2040 AM 

  

Figure 18 - Project Settings Options Tab - 2040 PM 

  

 

4. Simulation Parameter Settings  
 
The simulation parameters can be accessed via the TransModeler menu via the Parameters tab.  These settings 
shall not be changed.  They are described here as a reference to the specific settings used in the MSA networks.  
 

a. The Vehicle Class table can be found by accessing Parameters->Vehicle Fleet->Class and is displayed in the 
Figure 19.  
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Figure 19 - MSA Vehicle Class Table Settings 

 

As illustrated in Figure 19, five vehicle class percentages are defined.  There are percentages included for 
the three passenger car classes (PC1, PC2, and PC3), the PU classification (which includes pickup trucks, 
vans, and SUVs); and the Motorcycle classification. 

No percentages are shown for two classes of trucks, buses and articulated transit buses, trains, and 
bicycles.  The truck class percentage information is provided separately in the truck trip matrices.  Buses, 
articulated transit buses, trains, and bicycles are not used in the MSA vehicle classifications. 

The Auto Matrices (Auto.mtx and Auto_warmup.mtx) include the vehicle composition as shown above. 
The Truck Matrices (Trk.mtx and Trk_warmup.mtx) are composed of ST (single truck) and TT (truck-trailer) 
vehicles. These parameters shall not be modified. 

b. Driver Behavior 

The driver behavior table can be found by accessing Parameters->Driver Behavior. These parameters shall 
not be modified. 

c. Simulation Options 

The Simulation Options settings can be accessed by Simulation->Options.  

In the Mode tab in the Run section, there are several options for running the simulation.  The options 
most applicable to developing and evaluating ATCs are the Simulation, Dynamic Traffic Assignment, and 
Batch Simulation options.   
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The Simulation button should be selected when it is desired to perform a visual check of the network 
operation.  This is useful to verify network changes are functioning properly and to identify areas of 
congestion within the network.  The settings that should be used when the Simulation button is selected 
are shown in Figure 20.   

For ATC’s which include changes to the roadway network, dynamic traffic assignment (DTA) will need to 
be completed in order to generate historical travel times and turning delay files. The settings used for 
running a Dynamic Traffic Assignment (DTA) are shown in Figure 21.  These settings are established at the 
scenario level in the project and shall not be changed. 

 

Figure 20 - Simulation Mode Settings 

 

Figure 21 - Dynamic Traffic Assignment Mode Settings 

 

After the completion of the DTA, historical travel time and turning delay files shall be added to the Routing 
Settings and visual checks of the paths shall be completed to ensure that appropriate paths are being 
utilized (for example vehicles are not going through multiple loops at an interchange), and volume is not 
being excessively re-routed to adjacent interchanges and arterials. Volumes at key locations should be 
checked to ensure they are relatively consistent with the MSA. If extraneous paths are found that are 
impacting the operations, they should be deleted from the path file. If the path file is altered, the path file 
shall be attached to each of the Input Matrices as shown in Figure 22. 

After the DTA and the visual check and adjustment of travel paths have been completed, a Batch 
Simulation shall be performed to generate the measures of effectiveness for the morning and afternoon 
peak hour conditions for the ATC.  The settings used for running a Batch Simulation are shown in Figure 
23.  
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These settings are established at the scenario level in the project.  The Batch Simulation settings are used 
to generate 10 simulation runs which shall be averaged together to prepare the output measures of 
effectiveness.   

When the Batch Simulations are run, the random seeds shall be 7,12,17,22,27,32,37,42,47,52.  Once the 
Batch Simulation is completed, outputs can be extracted and processed using the Output Template 
described below. 

Figure 22 – Path File Settings 

 

Figure 23 - Batch Simulation Mode Settings 
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5. Outputs and Measures of Effectiveness 

Output Template files have been provided to be used in the comparison of ATC results with the 2040 MSA results. 
These templates shall be used for freeway, arterial and intersection operations, as well as overall network 
performance. The templates provided include each set up for all data that is to be extracted from the output files. 

a. Freeway Operations Performance 
To assess the freeway operations, the output template file shall be used to obtain volume, speed, and 
density for the basic freeway, merge/diverge, and weave segments along I-26, I-20, and I-126 within the 
study area. Include segment numbers so that accurate comparisons can be made between models. 
Additional volume and queue data shall be provided for the ramps along the interstates within the study 
area. The following information shall be provided in the tables: 

• AM and PM Mainline/Merge/Diverge/Weave Densities and LOS  
• AM and PM Mainline and Ramp volumes 
• AM and PM Ramp Queue Lengths 
• AM and PM Mainline Speeds 

Average freeway segment speeds shall be added to the segment database for the development of 
network speed figures. The Color Theme file provided with the MSA file shall be used to illustrate 
mainline speed and to facilitate comparison of the ATC to the 2040 MSA (similar to Figure 24). 

b. Arterial Operations Performance 
To assess the arterial operations, the output template file shall be used to compare the ATC to the 
2040 MSA for the study area intersections outlined in Table 1 and Table 2. The following information 
shall be provided in the tables: 

• Intersection/Approach/Movement Delays and LOS 
• Intersection Queue Lengths (95th Percentile, Average and Maximum Spillback) 
• Arterial Travel Times 

a. Broad River Road (Greystone Blvd to west of Exit 101) 
b. Bush River Road (West of Exit 63 to Broad River Road) 
c. Colonial Life Boulevard (I-126 Ramps to Bush River Road)  

 
c. Network Performance  

In addition to illustrating the freeway and arterial performances, network-wide performance measures 
shall be provided that compare the ATC and the 2040 MSA scenarios. The following performance 
measures have been identified for comparison purposes: 

• AM and PM Vehicle Miles Traveled 
• AM and PM Vehicle Hours Traveled 
• AM and PM Total Completed Trips 
• AM and PM Total Denied Entry 
• AM and PM Interstate End to End Travel Times 
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d. Additional Potential Performance Measures 
In addition to the previous performance measures, the following performance measures have been 
identified for as potential measures that may be useful for comparison purposes: 

• Average peak hour speeds per segment (color coded table format) 
• Mainline segment LOS (percent of total segments by LOS). 
• Average Speed/Density by segment 
• Speed by segment comparison to alternatives  
• Freeway travel times bar charts  
• Cumulative Travel Times for Freeways 
• Vehicle Throughput (for major throughput routes) 
• Throughput comparison in table with % change 
• Ramp Queue Spillback 
• TransModeler vs free-flow travel time comparison  
• TransModeler volumes vs balanced count comparison  
• Intersection LOS pie charts and tables 

 
The output template files shall be used to compare the ATC to the 2040 MSA for each of the identified 
performance measures. 

Figure 24 – Segment Speeds 
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6.  Maintenance of Traffic Analysis 
 
The following information relates to elements of creating and running the simulations for the Maintenance of 
Traffic Phases. 
 

a. Transmodeler Network Coding 
 

• The MOT analysis shall be completed in the same version of TransModeler with the 
version used for the MSA.   

• The MOT network in the TransModeler network shall match the MOT alternative 
depicted in the plan submittal  

• Code merge areas, link connectors, lane connectors and lane usage as described in the 
MSA guidelines 

• Do not overlap links, such as ramp and mainline links 
• Freeway crossover links (across a median) shall be coded as one-way, single lane links.   

a. When freeway crossover links are used, two-way traffic shall be modeled using 
a pair of one-way segments in opposite directions on what was previously 
coded as a single one-way segment in a single direction.  A two-way freeway link 
shall not be coded.  For example, if westbound freeway traffic is to crossover to 
the eastbound side, the two-way crossover shall be coded as a pair of separate 
westbound and eastbound one-way segments.  The original eastbound one-way 
segment shall not be converted to a two-way segment. 

• Review and address error messages related to network coding 
• Maintain segment numbers to the extent possible to facilitate comparisons to the base 

condition 
• No clipping of the MOT area from the entire network model shall be permitted  

a. The entire network model shall be used for the MOT analysis; using a sub-
section of the TransModeler network clipped to model just the MOT area shall 
not be permitted 

b. Using the entire network model will indicate the impact of the MOT alternative 
on network performance and ensure that key structural elements of the 
network (lane connectors, etc.) remain present in the MOT network 

• Appropriate adjustments in roadway class for the work zone shall be used  
a. For example, speeds of 70 mph and link capacities of 2,400 vehicles per lane are 

not appropriate for freeway work zone conditions 
b. Classes that incorporate appropriate work zone speeds and link capacities shall 

be required 
c. This may require creating a new Road Class for ‘Construction’ under the 

microscopic tab 
i. All links within the MOT construction area shall be included in the new 

Road Class 
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ii. Speed distribution on these links shall be changed to ‘Work Zone’  
b. Transmodeler Network Settings 

• AM and PM vehicle and truck matrices provided with the MSA network shall be used 
• Vehicle paths shall be present for all vehicle categories and O-D pairs 
• Vehicle paths shall be checked for reasonableness 

a. For example, mainline traffic should remain on the freeway through an 
interchange area and not exit and re-enter at an interchange 

• AM and PM peak hours shall be analyzed separately using the appropriate matrices 
• Traffic signals and signal timings shall not be removed unless removed as part of the 

MOT/detour plan 
• Simulation warm-up times shall not be shortened or eliminated 
• Peak hour volume should be spread over the peak hour modeling period only, and not 

also in all or part in the warm-up period. 
c. Transmodeler Simulations and Outputs 

• Output summaries shall report the 60-minute peak hour results, and shall not include 
the warm-up period results 

• Simulation observations shall be completed to ensure effective operation of the MOT 
plan and to verify vehicles in the simulations are behaving properly.  Improper behavior 
includes, but is not limited to, sudden appearance or disappearance of vehicles within 
the network or at crossovers, exiting and re-entering the mainline at an interchange, 
etc. Simulation observations for both peak hours shall be included as part of the MOT 
analysis operational reporting. 
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